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1. Mikä on Confluence?

Confluence on yhteisöllisen median  väline, jonka avulla voidaan tuottaa vuorovaikutteisia WWW-sivustoja wiki- eli ryhmätyöperiaatteen mukaisesti. Kunkin 
työtilan omistaja voi määrittää käyttäjät, jotka voivat muokata joko työtilan kaikkia sisältöjä tai työtilan omistajan määrittämiä sivuja.

2. Miten järjestelmään kirjaudutaan?

2.1. Metropolian opiskelijat ja henkilökunta

2.1.1. Mene wikin etusivulle ( , opetuksen ja opiskelun työtilat) tai  (kaupallisethttps://wiki2.metropolia.fi https://wiki.metropolia.fi
 projektit) 

2.1.2. Metropolia Log in
2.1.3. Syötä Metropolia tunnuksesi ja salasanasi 

2.2. Muiden suomalaisten ammattikorkeakoulujen ja yliopistojen edustajat 

https://wiki2.metropolia.fi
https://wiki.metropolia.fi


2.1.1. Mene wikin etusivulle (https://wiki.metropolia.fi)
2.1.2. Haka-login
2.1.3. Valitse kotiorganisaatiosi
2.1.4. Syötä omassa organisaatiossa käyttämäsi tunnus ja salasana. Tunnus voi olla esimerkiksi muotoa käyttäjätun

 tai   nus@kotiorganisaatio.fi etunimi.sukunimi@kotiorganisaatio.fi
 

3. Miten avataan/alustetaan/perustetaan oma työtila?

3.1. Henkilökohtainen työtila

3.1.1 Aktivoi oma Metropolia-tunnuksesi osoitteessa , mikäli et ole sitä vielä tehnyt.http://activation.metropolia.fi
3.1.2. Mene Confluencen etusivulle ( ).http://wiki.metropolia.fi
3.1.3. Kirjaudu sisään Confluenceen ("Metropolia Log in", oikea yläkulma)
3.1.4. Käyttöliittymän oikeassa yläkulmassa näkyy nimesi/kuvasi, jonka oikealla puolella on nuoli. Avaa valikko viemällä kohdistin nuolen päälle.
3.1.5. Klikkaa "Personal Space".
3.1.6. Olet henkilökohtaisella Confluence-sivullasi, johon voit alkaa tuottaa sisältöä "Edit Profile" -nappulasta. Kirjoita sivun otsikoksi esimerkiksi 
nimesi.
3.1.7. "Save".

3.2. Opinnon tai projektin työtila 

3.2.1. Aktivoi oma Metropolia-tunnuksesi osoitteessa , mikäli et ole sitä vielä tehnyt.http://activation.metropolia.fi
3.2.2. Ehdota työtilaa perustettavaksi ja ano työtilan omistajan oikeuksia Metropolian .Helpdeskistä
3.2.3. Odota, että työtilaehdotuksei saadaan käsiteltyä. Työtilaan johtava linkki ilmestyy Confluencen etusivulle vasemmanpuoleiseen 
sarakkeeseen sen jälkeen, kun työtila on alustettu.

4. Miten tehdään uusi sivu?

4.1. Mene työtilaasi
4.2. Create -> Blank Page
4.2. Kirjoita sivun otsikko ylimpään laatikkoon (korvaa New Page -teksti otsikolla).
4.3. Sijoita sivun sisältö työkaluvalikon alapuolella olevan nelikulmion sisään.
4.4. Muokkaa sisältö (väliotsikot, linkit, kuvat).
4.5. Tallenna (painamalla Save) tai poista (Cancel). 

5. Miten sivua muokataan?

5.1. Edit
5.2. Tee tarvittavat muutokset.
5.3. Save. Huom! Sivut päivittyvät 15 sekunnin viipeellä! Tieto päivityksestä ei aivan heti näy wikin etusivulla!

6. Miten tehdään linkki?

6.1. Linkki Confluencen ulkopuoliseen sivuun 

6.1.1. Kopioi sen sivun osoite, johon linkki viittaa. 
6.1.2. Siirry Confluencen Edit-tilaan. 
6.1.3. Maalaa linkiksi herkistettävä merkkijono.
6.1.4. Valitse linkkityökalu (Link)
6.1.5. Web Link
6.1.5. Liitä sivun osoite laatikkoon "Address".
6.1.6. OK.

6.2. Linkki toiseen Confluence-sivuun

6.2.1. Siirry Edit-tilaan. 
6.2.2. Maalaa linkiksi herkistettävä merkkijono.
6.2.3. Valitse linkkityökalu (Link)
6.2.4. Valitse Search-laatikosta sivu, johon linkki viittaa (kirjoita linkattavan sivun otsikko tai osa siitä)
6.2.5. OK.

7. Miten sivun kuvia hallitaan?

7.1. Miten sivulle lisätään kuva?

7.1.1. Edit
7.1.2. Aseta kohdistin kohtaan, johon haluat kuvan sijoittaa.
7.1.3. Insert -> Image
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https://wiki.metropolia.fi%29/
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7.1.4. Valitse kuva
7.1.5. Insert

7.2. Miten sivulla oleva kuva poistetaan?

7.2.1. Edit
7.2.2. Oikeaklikkaa kuvan päällä
7.2.3. Poista/delete
7.2.4. Tallenna sivu

7.3. Miten sivulla oleva kuva vaihdetaan?

7.3.1. Poista vaihdettava kuva (ks. 7.2.)
7.3.2. Liitä sivulle uusi kuva (ks. 7.1.)

7.4. Miten kuvan fyysistä kokoa muokataan?

7.4.1. Edit
7.4.2. Klikkaa kuvan päällä
7.4.3. Klikkaa jokin oletusarvoista (vierekkäiset eri kokoiset neliöt) tai määritä kuvan leveys manuaalisesti pikseleinä (poista 
kuvatyökalun  vasemmanpuoleisessa kentässä jo valmiina oleva arvo (esimerkiksi 400px) ja kirjoita tilalle uusi arvo (esimerkiksi 500px).
7.4.4. Save

7.5. Miten kuva asemoidaan?

7.5.1. Edit 
7.5.2. Klikkaa kuvan päällä
7.5.3. Valitse wikiohjelman työkaluriviltä Align left (asemoi sivun vasempaan reunaan), Align center  (keskelle) tai Align right (oikealle).

7.6. Miten teksti saadaan kiertämään kuvan ohi?

7.6.1. Edit
7.6.2. Klikkaa kuvan päällä
7.6.3. Asemoi kuva sivun oikeaan reunaan (ks. 7.5.3.)

8. Sivunmuokkauksen muita työkaluja 

8.1. Työkalurivi

B lihavointi

I kursivointi

Paragraph mm. otsikoiden merkintä (Heading 1, Heading 2 jne.)

Table taulukko

Bullet list numeroimaton luettelo

Numbered list numeroitu luettelo

Indent sisennys

Insert mm. kuvan, liitetiedoston ja makron lisäys

Page layout Sivun asettelun muokkain

Undo Komennon peruuttaminen

8.2. Muita oleellisia
 

Cancel Poista.

Minor change? Confluence tiedottaa muutoksista työtilan muille käyttäjille. Ihan pieniä muutoksia ei kannata kuuluttaa. Silloin rasti tähän.

Comment Kommentit sisällöstä.

Location Sivun sijainti hakemistorakenteessa.

Unrestricted / Restrictions Tässä voi rajoittaa jonkun tai joidenkin oikeutta lukea tai muokata sivua.

Labels Asettaa sivulle labelin, esim. language-fi (suomenkielinen sivu)



9. Sivujen poisto, siirto ja palauttaminen

9.1. Miten sivu poistetaan?

Sivun voi poistaa se, jolle työtilan paikallinen admin on antanut Pages Remove -oikeuden. 

9.1.1. Mene poistettavalle sivulle
9.1.2. Tools -> Delete

Huom! Delete-toiminto siirtää sivun ja siihen mahdollisesti kiinnitetyn liitetiedoston Confluencen roskakoriin (Trash), jonka tiedostot näkyvät mm. Googlen 
hauissa mutta eivät Confluencen omalla hakukoneella. Jos sivu ja sen liitetiedostot pitää hävittää lopullisesti, tulee tiedosto poistaa erikseen myös 
Confluencen roskakorista (Browse/Space tools -> Space admin -> Trash -> Purge).  

Huom! Delete-toiminto hävittää myös poistettavaan sivuun kytketyt liitetiedostot.

9.2. Miten sivu siirretään työtilan (space) sisällä toiseen hakemistoon?

9.2.1. Mene siirrettävälle sivulle
9.2.1. Tools -> Move
9.2.2. Kirjoita New parent page -kenttään sen hakemiston nimi, jonka alle sivu siirretään 

9.3. Miten sivusta palautetaan aikaisempi versio?

9.3.1. Mene sivulle, jonka aikaisempi versio pitää palauttaa
9.3.2. Tools -> Page history
9.3.3. Valitse palautettava versio klikkaamalla version nimeä (esimerkiksi Version 33)
9.3.4. Restore this version

9.4. Miten Delete-napin avulla poistettu sivu palautetaan?

(Palautuksen pystyy tekemään työtilan paikallinen admin)

9.4.1. Browse -> Space admin -> Trash
9.4.2. Valitse palautettavan sivun kohdalta Restore

10. Miten oikeuksia hallitaan?

10.1. Työtilat ja henkilökohtaiset sivustot

Kunkin työtilan omistaja eli paikallinen admin voi säätää työtilansa luku- ja kirjoitusoikeuksia Permissions-sivulla, joka on polussa Browse -> Space Admin -
> Permissions

Oikeuksia säädetään Permissions-sivulla seuraavasti:

10.1.1. Groups-väliotsikon alla voi työtilaan liittää  esimerkiksi jonkin klusterin henkilökunnan ja opiskelijat. Kullekin ryhmälle voi määrittää ryhmiä,
luku- ja kirjoitusoikeuksia.  .Opas
10.1.2. Individual users -väliotsikon alla voi työtilaan liittää  tunnuksia. .yksittäisten henkilöiden Opas
10.1.3. Anonymous access -väliotsikon alla voi säädellä työtilan näkyvyyttä . Jos rasti laitetaan ruutuun Metropolian wikiin kirjautumattomille
kohdassa View, näkyy työtila myös niille, jotka eivät ole kirjautuneet Metropolian wikiin (eli käytännössä Metropolian ulkopuolisille käyttäjille).

10.2. Yksittäiset hakemistot ja sivut

Voit asettaa oikeuksia wikin tietylle hakemistolle tai sivulle. Tietyn hakemiston etusivulle asetettu oikeus pätee myös hakemiston alahakemistoissa. 

10.2.1. Mene sivulle tai sen hakemiston etusivulle, jolle haluat asettaaa oikeuksia.
10.2.2. Edit
10.2.3. Klikkaa Restrictions-sanan jälkeen tulevaa Edit-linkkiä
10.2.3. Aseta oikeudet lukemiselle (Restrict viewing of this page) ja muokkaamiselle (Restrict editing of this page). 

10.3. Miten Restrictions-määritelmät annetaan?

10.3.1. Valitse, koskeko Restrictions-määritelmä lukemista (View) vai muokkaamista (Edit).
10.3.2. Valitse henkilöt, jotka saavat View- tai Edit-oikeuden.
10.3.2.1.  Choose users
10.3.2.2. Kirjoita henkilön sukunimi kenttään Full name -> Search
10.3.2.3. Valitse henkilö laittamalla rasti käyttäjätunnuksen edessä olevaan laatikkoon
10.3.2.4. Select user
10.3.2.5. Save

10.4. Keskeneräisten sisältöjen hallinta

Keskeneräisen sisällön voi kirjoittaa wikiin ja sulkea ulkopuolisilta seuraavasti:

10.4.1. Kirjoita sivun raakaversio siihen kohtaan hakemistoa, jossa se on tarkoitus aikanaan julkaista

https://wiki.metropolia.fi/pages/viewpage.action?pageId=23203710
https://wiki.metropolia.fi/pages/viewpage.action?pageId=20154320


10.4.2. Klikkaa Restrictions-riviltä Edit (sivun alhaalla).
10.4.3. Valitse Restrict viewing of this page ja Me.
10.4.4. Restrict
10.4.5. Save

Viimeistelty sivu julkaistaan seuraavasti:

10.4.6. Mene takaisin sivun Restrictions-määritelmiin ja poista rajoitus (Remove restriction).

10.5. Miten tehdään työtila, joka näkyy Metropolian sisällä opiskelijoille ja henkilökunnalle mutta ei Metropolian 
ulkopuolelle?

10.5.1. Browse -> Space admin -> Permissions (tai:Space tools -> Permissions)
10.5.2. Mene väliotsikon Groups alle .-> Edit permissions
10.5.3. Kirjoita Edit permissions to -kohtaan role:all:member
10.5.4. Save

10.6. Miten työtilaan liitetään Metropolian ulkopuolisia käyttäjiä?

10.6.1. Lähetä Metropolian  palvelupyyntö ulkopuolisista tunnuksista. Pyyntöön kirjoitetaan .käyttäjätukeen tarvittavat tiedot
10.6.2. Käyttäjätuki lähettää tunnukset sinulle sen jälkeen, kun ne on tehty
10.6.3. Liitä tunnukset työtilaasi Individual users -väliotsikon alle luvun 10.1. mukaisesti

11. Labelit

11.1. Team label

12. Makroilla ja plugineilla lisäominaisuuksia sivuille

12.1.  (mm. sisällysluettelo, RSS, Include, Calendar, Gallery, Content by label, Recently updated)Eri makroja
12.2. Gliffylla diagrammeja

13. Miten työtilan nimeä vaihdetaan?

Työtilan paikallinen admin eli hallitsija voi vaihtaa työtilan nimeä (eli sitä nimeä, joka näkyy Metropolian wikin etusivulla) seuraavasti:

13.1. Browse/Space tools
13.2. Space admin
13.3. Edit space details
13.4. Laatikossa "Name" voi muokata työtilan nimeä
13.5. Laatikossa "Description" voi muokata työtilan kuvausta (näkyy Metropolian wikin etusivulla työtilan otsikon alla)
13.6. Save

14. Miten työtilalle valitaan ulkoasu

Työtilan ulkoasua pystyy sen paikallinen admin säätämään:

14.1. Browse/Space Login
14.2. Space admin
14.3. Themes
14.3.1. Valitse haluamasi ulkoasuteema
14.3.2. Confirm 

14. Miten työtilasta tehdään PDF-tiedosto?

Työtilan pystyy sen paikallinen hallitsija eli admin muuttamaan (esimerkiksi) tulostettavaksi PDF-tiedostoksi. .Opas

15. Tekijänoikeudet ja tietoturva

Metropolian ulkopuolisen tahon tuottama aineisto on yleensä tekijänoikeuslainsäädännöllä suojattua. Ennen sellaisen aineiston lataamista wikiin 
on asiasta keskusteltava pääkäyttäjän kera: petri.silmala@metropolia.fi

16. Metropolian Confluenceen  tehtyjen versiopäivitysten vaikutuksia

v5.4.

17. Laajempia Confluence-oppaita 

17.1. Suomenkielisiä

Helsingin yliopisto: Confluence-ohjeet:
http://wiki.helsinki.fi/display/support/Confluence-ohjeet
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17.2. Englanninkielisiä

Confluence User Guide:
http://confluence.atlassian.com/display/DOC/Confluence+User+Guide
Confluence documentation: http://confluence.atlassian.com/display/CONF210/Confluence Documentation Home

18. Katso myös

Sosiaalisen median henkilöstökoulutusta Metropoliassa

Noudata näitä!

Käytä makroja ja lisäosia vain silloin, kun on aivan pakko. Makro tai lisäosa saattaa wikialustan seuraavassa versiopäivityksessä muuttua Metropolian 
ulkopuolisen ohjelmistovalmistajan päätöksellä joko toimimattomaksi tai maksulliseksi. Jotkut makrot myös hidastavat sivun latautumista.

Älä käytä itse tehtyjä CSS-sivupohjia. Tai jos käytät, niin omalla vastuulla. Ne  vääntää sivun muotoilut epäsuotuisasti wikialustan saattavat
versiopäivityksessä tai muuttaa sivun suorastaan käyttökelvottomiksi.

Vaihda Documentation-ulkoasuteema joksikin muuksi. Browse (tai  Space tools, vasemmalla alhaalla) -> Space admin -> Themes.

Varmista, että anonyymi kommentointi on työtilassasi estetty. Mene oikeuksienmäärityssivulle (Browse tai Space tools -> Permissions -> Varmista, 
että Annomyous Access -väliotsikon alla  (eli v:tä) kohdassa Comments Add.ei ole rastia
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